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Witaj w URVE Manager 
 

URVE Manager to oprogramowanie, które umożliwia łatwe i szybkie a jednocześnie profesjonalne 
zarządzanie urządzeniami Digital Signage. Tworzenie zaawansowanych prezentacji multimedialnych  
i aktualizacja nośników cyfrowych jeszcze nigdy nie była tak łatwa i przyjemna. 

Platforma URVE to kolejny krok ewolucyjny oprogramowania URVE. Dzięki zdobytemu doświadczeniu  
i specyficznym wymaganiom klientów, oprogramowania zostało wzbogacone o dodatkowe funkcje,  
zaś poprzednie możliwości zostały dopracowane i dostosowane pod kątem intuicyjnej nawigacji  
i obsługi. 

Mamy nadzieję, iż nowa wersja platformy spełni Państwa oczekiwania, ułatwi współpracę z systemem 
i jednocześnie pozwoli na zwiększenie zysków i korzyści z rozwiązań Digital Signage. 
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Kto powinien przeczytać instrukcję? 
 

Niniejszą instrukcję powinny przeczytać wszystkie osoby, które zajmują się lub będą zajmowały się 
zarządzaniem urządzeniami Digital Signage, wyposażonymi w oprogramowanie URVE. Nie mniej 
jednak, program został stworzony według klasycznych konwencji programistycznych i wielu 
użytkowników będzie w stanie nauczyć się obsługi URVE Manager samodzielnie, w trakcie korzystania 
z programu. 

Nowi użytkownicy 
Praca w obrębie platformy URVE obejmuje oprogramowanie URVE Player, URVE Manager oraz 
opcjonalnie URVE Server. Przy pomocy aplikacji można zarządzać pojedynczym monitorem lub siecią 
monitorów reklamowych, kontrolując zawartość emitowanych treści, ich kolejność, godziny wyświetleń 
oraz wiele innych parametrów. 

Użytkownicy poprzednich wersji 
W stosunku do poprzedniej wersji w platformie URVE zostało wprowadzonych wiele istotnych zmian. 
Wśród najważniejszych należy wymienić możliwość zarządzania ułożeniem klipów  
na „wirtualnym” obrazie, przypisanie określonych właściwości do poszczególnych cech oraz 
zaawansowany ticker tekstowy.  

Najlepszym sposobem, aby przekonać się, jak zaawansowane narzędzie do zarządzania urządzeniami 
Digital Signage oddajemy do użytku, jest przeczytanie niniejszej instrukcji oraz samodzielne 
sprawdzenie opcji programu.  

Jeżeli pojawią się kwestię niewspomniane w instrukcji zapraszamy na stronę internetową 
www.eveo.pl, gdzie można odnaleźć dodatkowe materiały tekstowe oraz filmowe dotycząca pracy w 
obrębie programu. W przypadku zaawansowanych zagadnień prosimy o bezpośredni kontakt z działem 
technicznym: 

E-mail: serwis@eveo.pl 

Tel: 500 026 696 

Jeżeli w niniejszej instrukcji pojawią się braki lub błędy, będziemy wdzięczni za wszelkie zgłoszenia, 
zaś braki niezwłocznie usuniemy. Błędy i sugestie prosimy zgłaszać pod adresem info@eveo.pl. 

Czego się nauczysz? 
 

• Tworzenie profilu 

• Edycja i podgląd tworzonego profilu 

• Aktualizacja playerów w sieci 

• Dodawanie i edycja klipów 

• Dodawanie oraz edycja tickerów tekstowych 

• Zarządzanie kolejnością wyświetlanych materiałów multimedialnych  

• Zmiana parametrów klipów 
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Zanim rozpoczniesz 
 

Przed rozpoczęciem nauki sugerujemy wydrukowanie instrukcji, tak aby ułatwić pracę podczas 
poznawania programu. 

W trakcie korzystania z programu nie trzeba wykonać wszystkich ćwiczeń w czasie jednej sesji. W 
każdej chwili można zapisać postępy swoje pracy wybierając opcję Zapisz (Save) dostępną na pasku 
narzędzi lub w menu Plik (File). Zapisany kanał (profil) można otworzyć poprzez opcję Otwórz profil 
(Open profile) dostępną w menu Plik (File). 

Zalecamy, aby w trakcie nauki wykonać wszystkie ćwiczenia opisane w instrukcji. Umożliwi to lepsze 
poznanie programu i późniejszą pacę z zaawansowanymi funkcjami URVE Manager. 

Co będzie potrzebne? 
 

Aby wykonać wszystkie ćwiczenia przedstawione w instrukcji będą potrzebne: 

• Pliki filmowe, audio, zdjęcia oraz pliki graficzne   

• Komputer z dostępem do sieci LAN lub WLAN 

• Aplikacja URVE Manager zainstalowana na komputerze 

• Opcjonalnie zdalny player skonfigurowany do połączenia z URVE Manager (zdalny player nie 
jest wymagany, ponieważ w Aplikacji URVE Manager dostępny jest podgląd kanału (profilu). 

 

URVE Manager odpowiedzialny jest za dodawania i zarządzanie przeznaczonymi  
do wyświetlania materiałami multimedialnymi. Wśród funkcjonalności aplikacji możemy odnaleźć: 

• Tworzenie listy klipów 
• Zarządzanie długością wyświetlania klipów 
• Wskazanie kolejności odtwarzania 
• Manipulowanie zawartością „pasków informacyjnych” – tickerów tekstowych 
• Aktualizację kanałów (profili) poszczególnych urządzeń 
• Wyświetlanie stron WWW 
• Podgląd profilu 
• I wiele, wiele więcej… 

URVE Player służy do interpretacji wprowadzonych zmian oraz poprawne wyświetlenie zadanych treści 
na urządzeniu docelowym.  

Oba programy mogą współpracować ze sobą zarówno na jednym komputerze jak i zdalnie, poprzez 
połączenie LAN lub WAN.  

UWAGA 

Jeżeli wymagana jest konfiguracja komputera lub systemu URVE prosimy o zapoznanie się z 
dodatkowymi instrukcjami obejmuącymi wybrane zagadnienia instalacyjne. 
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URVE Server wykorzystywany jest w rozproszonych sieciach i służy do przesyłania informacji na 
playery. 

Wymagania Systemowe 
Minimalne: 
Intel 600 MHz lub platforma zgodna 

128 MB RAM 
50MB wolnego miejsca na dysku 
PenDrive USB lub połączenie sieciowe 
System operacyjny Windows XP lub Windows Vista lub wyżej 

Zalecenia dotyczące wymagań 
Ze względu na możliwości wykorzystania interfejsu AERO, zalecamy wykorzystanie komputerów  
z zainstalowanym systemem operacyjnym Microsoft Windows Vista (Premium/Bussines/Ultimate) lub 
wyższe wraz z odpowiednimi parametrami sprzętowymi (wskazanymi przez producenta 
oprogramowania Microsoft) lub wyższy. 

Ze względu na obsługę poszczególnych plików może być wymagany Media Player 9 lub odpowiednie 
kodeki. Zalecane kodeki dostępne są do pobrania na stronie www.eveo.pl/  

 

 

 

 

UWAGA 

Podane wyżej wymagania są paramtrami minimalnymi do uruchomienia aplikacji URVE 
Manager. Parametry i wydajność playera oraz komputera zarządzającego powinny być zawsze 
dostosowane do przewidzianego contentu i jakości odtwarzanych materiałów multimedialnych. 

UWAGA 

Aby efekty uzyskane podczas tworzenia Playlisty lub Profilu funkcjonowały także na urządzeniu 
docelowym należy upewnić się, co do zgodności parametrów sprzętowych, systemu 
operacyjnego oraz kodeków graficznych zarówno na komputerze odtwarzającym jak  
i zarzadzajacym. 
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PODSTAWY 
 

Pierwsze uruchomienie 
 

Podczas każdego uruchomienia systemu na ekranie może pojawić się następujący preloader. 

Rysunek 1 URVE Manager Preloader 

  

Preloader zniknie po uruchomieniu aplikacji i w zależności od prędkości komputera jego długość 
wyświetlania może się różnić. 

Rejestracja licencji 
 

Jeżeli na danym komputerze jest to pierwsze uruchomienie URVE Manager, pojawi się okno dialogowe 
z prośbą o wpisanie numeru seryjnego. W odpowiednie pola należy wpisać dane umieszczone na 
naklejkach licencyjnych znajdujących się w pudełku wraz z nośnikiem CD. 

Użytkownik / USER NAME 

Wersja / VERSION CODE 

Numer seryjny / SERIAL NUMBER 
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Rysunek 2 URVE Manager Rejestracja 

 

Jeżeli okno dialogowe się nie pojawi można sprawdzić na jakie dane licencyjne został zarejestrowany 
program. Na pasku tytułowym programu wyświetla się VERSION CODE (Wersja), na który została 
zarejestrowana licencja. 

Rysunek 3 URVE Manager Licencja 

 

Wyrejestrowanie licencji 
 

W przypadku błędnie zarejestrowanej licencji lub konieczności zmiany licencji (np. dokupienie 
kolejnych licencji) należy wybrać opcję dostępną w menu 

URVE ’09 -> Wyrejestruj  (URVE ‘09 -> Unregister)  

Po czym wyłączyć aplikację URVE Manager i uruchomić ją ponownie. 

Proces ponownej rejestracji licencji pozostaje bez zmian. 
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Interface programu 
 

W trakcie nauki Użytkownik zapozna się z różnymi opcjami programu. Główne okno przestawione 
poniżej jest podstawowym miejscem pracy. Z tego widoku można przejść do wszystkich opcji 
dostępnych w programie i zarządzać wszelkimi dostępnymi parametrami.   

Rysunek 4 URVE Manager Interface 

 

Obszar roboczy URVE Manager na którym zarządzamy klipami statycznymi (Playlista ) 

W dolnej części obszaru roboczego znajdują się zakładki, dzięki którym można przełączyć widok na 

listę klipów dynamicznych , harmonogram zdarzeń oraz szczegóły playera.  

Domyślnie program uruchamia się na głównej playliście klipów statycznych. 

Informacje, dotyczące funkcjonalności poszczególnych ikon zarówno w Menu jak i na paskach narzędzi 
w programie, pojawiają się po najechaniu wskaźnikiem myszki na odpowiedni punkt. 
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Paski 

Pasek menu 
 

Rysunek 5 Pasek Menu 

 

 

Pasek narzędzi (Toolbar) 
 

Rysunek 6 Pasek narzędzi (Toolbar) 
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Panele 
Na szczególną uwagę zasługują także panele, w których przełączanie pomiędzy zakładkami umożliwia 
wykorzystanie nowych funkcji zawartych w programie. 

Panel powitalny (Welcome Panel) 
Panel powitalny ma za zadanie ułatwić i przyśpieszyć pracę z URVE Manager. Znajdują się tutaj 
podstawowe funkcję do stworzenia nowego profilu, otworzenia już istniejącego oraz aktualizacji 
urządzenia wyświetlającego. W górnej części panelu znajdują się zakładki, dzięki którym można 
uzyskać szybki dostęp do wybranych funkcji. 

Rysunek 7 Panel Powitalny 

 

Zakładka URVE ułatwia rozpoczęcie pracy w programem. Użytkownik odnajdzie tutaj funkcje 
umożliwiające założenie nowego profilu lub otwarcie już istniejącego, jak również opcje aktualizacji 
urządzeń w sieci. 

Zakładka Media umożliwia szybkie zarządzanie plikami źródłowymi, które zostały dodane do 
programu. Dzięki możliwości przeglądania katalogów komputera ułatwia także dodawanie nowych 
klipów do Playlisty, przy pomocy funkcji Drag & Drop. 

Zakładka Players prezentuje pełną listę urządzeń odtwarzających dostępnych w obrębie sieci LAN 
oraz zdalne playery. 

Zakładka Screen Contents umożliwia szybkie zarządzanie poszczególnymi kolekcjami i obszarami 
ekranu (więcej informacji dotyczącej tej kwestii znajdują się części ZAAWANSOWNE niniejszej 
instrukcji). 

Zakładka Help umożliwia uzyskanie pomocy poprzez stronę WWW. 
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Panel właściwości klipu (Clip properties) 
W obrębie tego panelu znajdują się parametry służące do zarządzania właściwościami klipu oraz 
programowania zdarzeń związanych z klipem. W zależności od rodzaju pliku, panel może się różnić. 

 

Rysunek 8 Panel Właściwości 

 

 

Panel Management 
Panel służący do zarządzania, aktualizacji i synchronizacji urządzeń wyświetlających jak również 
uruchamiania zaawansowanych funkcjonalności w URVE Manager. 

 

Rysunek 9 Panel Zarządzania 
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Panel Preview 
Umozliwia podgląd aktualnie zaznaczonego klipu. W celu przyspieszenia pracy Managera zaleca się 
wyłączenie panelu. 

 

Rysunek 10 Panel Podglądu 
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Menu  

Menu kontekstowe 
Po najechaniu kursorem na wybrany obszar lub klip i kliknięcie prawym przyciskiem myszki 
wywołujemy menu kontekstowe. Zawartośc tego menu może różnić się w zależności od wskazanego 
obiektu. Przykład menu kontekstowego pliku jpg. Znajduje sie poniżej. 

 
Rysunek 11 Menu kontekstowe 
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Tworzenie kanału (profilu) 

Nowy kanał (profil) 
Tworzenie nowego kanału (profilu) w URVE Manager może odbyć się na kilka sposobów: 

1. Menu Plik → Nowy profil (Menu File → New Profile) 
2. Panel Powitalny →  Nowy profil (Panel Welcome  → New profile) 

W momencie utworzenia nowego kanału (profilu) otworzy się okienko kreatora w następującej 
postaci. 

Rysunek 12 Tworzenie nowego kanału 

 

Okno to umożliwia:  

Nadanie nazwy nowo tworzonego kanału (profilu) 

Wskazanie miejsca zapisania pliku timeline.config 

Włączenie funkcji trybu przeźroczystości (dostępne dla systemu operacyjnego Vista Premium) 

Wybranie rozdzielczości roboczej (pozostawienie tego parametru pustego, powoduje 

automatyczne ustawienie rozdzielczości, aktualnie funkcjonującej na komputerze  

z zainstalowanym URVE Manager) 

 

Po uzupełnieniu poszczególnych pól należy zatwierdzić zmiany przyciskiem „OK.” 

UWAGA 

Wybranie jednej z opcji rozdzielczości nie jest równoznaczne z konfiguracją urządzenia 
wyświetlającego. Należy się upewnić, czy rozdzielczość, dla której tworzymy ustawienia  
w URVE Manager, jest zgodna z rozdzielczością ustawioną na urządzeniu z zainstalowanym 
URVE Player. 
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Modyfikacja istniejącego kanału (profilu) 
W momencie, gdy zarządzamy zaawansowaną siecią urządzeń Digital Signage pomocne okazuje się 
zapisywanie różnych kanałów (profili) i modyfikacja ich, gdy zajdzie taka konieczność. W tym celu do 
programu wbudowana została opcja otwierania już istniejących kanałów (profili). Funkcja „Open 
profile” została dodana w: 

1. Menu plik -> Otwórz profil (Menu File -> Open profile) 
2. Panel Welcome -> Zakładka URVE -> Otwórz profil (Panel Welcome -> Open Profile) 

 

UWAGA 

Nie należy zmieniać nazwy pliku kanału (timeline.config). 

Aby zachować różne kałay (profile) należy zapisać je w osobnych katalogach. 
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Klipy 
 

Klipy to podstawowy składnik profilu tworzonego przez każdego Użytkownika. O sposobach dodawania 
klipów można dowiedzieć się w rozdziale Podstawy. Najbardziej popularne sposoby wykorzystania 
klipów przedstawimy w poniższym rozdziale. Zachęcamy jednak do samodzielnego tworzenia 
zaawansowanych profili gdyż jedynym ograniczeniem tego, co może być wyświetlane na monitorach, 
jest tylko nasza wyobraźnia. 

Obsługiwane formaty klipów 
 

URVE Manager umożliwia odtwarzanie i prezentowanie klipów kilku formatów. Listę akceptowanych 
formatów prezentujemy poniżej. 

• AVI; 
• MP4; 
• MPEG 1/2/4 (*.mpg); 
• RSS; 
• RAW DV; 
• MKV; 
• VOB; 
• HTML; 
• Quick Time (*.mov); 
• RVMB; 
• DivX (*.DivX); 
• Windows Media Video (*.wmv), odtwarzanie strumienia video; 
• obrazy statyczne (*.jpg, *.png, *.bmp, *gif); 
• pliki tekstowe (*.txt); 
• dokumenty (.pdf) z możliwością automatycznego skrolowania i skalowania 
• prezentacje PowerPoint (*.pps) - na komputerze zarządzającym musi być zainstalowany 

viewer, nie skaluje się do mniejszych okienek); 
• prezentacje wektorowe flash (*.swf), (*flv); 
• pliki wykonywalne *.exe; 
• pliki dźwiękowe: Windows Media Audio (*.wma), MP3 (audio), (*.ogg), WAV 
 

 

UWAGA 

Sposób dodania klipów specjalnych (np. PDF, EXE, źródło TV itp.) może nieznacznie różnić się 
od sposobu dodania standardowego klipu graficznego lub filmowego. Sposoby dodania klipów 
specjalnych zostaną opisane w dalszych częściach instrukcji lub są dostępne w osobnych plikach 
dostępnych na stronie www.eveo.pl .  
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Rodzaje klipów 
 

W Aplikacji URVE Manager wyróżniamy dwa podstawowe rodzaje klipów: statyczne oraz dynamiczne. 
Jako klipy statyczne określamy te klipy, które są wyświetlane kolejno po sobie i reprezentowane są  
w Managerze na zakładce Timeline. Jako Klipy dynamiczne określamy te klipy, które znajdują się na 
liście zakładki „Klipy dynamiczne” („Dynamic Clips”) i wywoływane są przez użytkownika na żądanie  
w określonym momencie trwania prezentacji klipów statycznych. 

 

Klipy statyczne 
To właśnie te klipy określają główną ścieżkę odtwarzania (Playlista) kanału (profilu) URVE. Stanowią 
niejako główny wątek odtwarzanych treści. Klipy statyczne mogą wywoływać klipy dynamiczne. Dzięki 
części Events widocznej w panelu Preperties możemy kontrolować akcje klipów dynamicznych. 
Obsługa zdarzeń dostępna jest poprzez język URVE Scriprt. 

Podstawowe zdarzenia w języka URVEScript to: 

• OnPlay – funkcja aktywowana w momencie rozpoczęcia odtwarzania klipu 
• OnStop - funkcja aktywowana w momencie zakończenia odtwarzania klipu 
• OnTouch - funkcja aktywowana w momencie „kliknięcia” obszaru na monitorze, 

wykorzystywana do zarządzania urządzeniami odtwarzającymi wyposażonymi w monitory, 
dotykowe 

• OnMenuTouch -  

W trakcie tych zdarzeń możemy wywołać następujące skrypty. 

• MonitorOn - włącza monitor za pomocą komendy VESA 
• MonitorOff - wyłącza monitor za pomocą komendy VESA 
• Play [id] - odtwarza klip dynamiczny o podanym numerze ID (z listy klipów dynamicznych) 
• PlayOnce [id] - odtwarza klip po pierwszym napotkaniu tej instrukcji w danym kanale (profilu). 

Wykorzystywany głównie podczas dodawania i zarządzania tickerem tekstowym 
• Stop [id] - wyłącza odtwarzanie klipu uruchomionego wcześniej (działa zarówno dla klipów 

statycznych jak i dynamicznych)  
• Wait [czas] – czeka z wykonaniem następnej komendy określony czas (w milisekundach) 

 

Więcej skryptów dostępnych jest na stronie www.eveo.pl w części Wsparcie. 

 

UWAGA 

Okno Właściwości klipu jest zawsze dostępne poprzez wybranie opcji Właściwości z menu 
kontekstowego danego klipu lub poprzez dwuklik myszką na wybranym pliku dodanym do URVE 
Manager. 

UWAGA 

W URVE Manager podczas dodawania klipu dynamicznego, jeśli użytwkonik nie nada ID klipu, 
numer ID zostanie automatycznie wygenerowany. Istnieje późniejsza możliwość zmiany numer 
ID w panelu Właściwości (Panel Properties). 
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Klipy dynamiczne  
Są to klipy, które pojawiają się w obszarze wyświetlania tylko na żądanie. Dodanie takiego klipu do 
programu URVE nie spowoduje jego wyświetlenia. Użytkownik sam musi określić, w którym momencie 
chce, aby dany klip dynamiczny został odtworzony. W celu ustalenia tych relacji wykorzystywany jest 
URVE Script opisany we wcześniejszej części instrukcji. Należy pamiętać, że każdy klip dynamiczny 
powinien mieć przypisany numer ID. 

Klipy dynamiczne mogą zostać powiązane z wybranymi playlistami i obszarami. 
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Dodawanie klipów 
 

Podobnie jak tworzenie nowego kanału (profilu), także dodawanie klipów do playlisty może odbywać 
się na kilka sposobów. 

1. Klikając prawym przyciskiem myszki na obszarze roboczym, zostanie wywołane Menu 
kontekstowe, z którego należy wybrać Dodaj klip (Add movie clip). 

2. Pasek narzędzi -> Dodaj (Toolbar -> Add) 
3. Menu Dodaj -> Dodaj klip  (Menu Add -> Add movie clip). 
4. Poprzez funkcję “Drag & Drop”, czyli przeciągnięcie pliku z folderu na obszar roboczy 

programu URVE Manager. 

Każdy z wyżej wymienionych sposobów, spowoduje otworzenie się nowego okna dialogowego w 
następującej postaci. 

 

Rysunek 13 Dodawanie klipu 

 

 

Okno to umożliwia:  

Wskazanie lokalizacji folderu zawierającego plik 

Dodanie informacji pomocniczych w postaci nazwy firmy („Company”), kontaktu („Contact”), 

komentarza („Info”), ID 

Ustawienie długości trwania klipu („Lenght”) 

Ustawienie, aby dany klip wyświetlał się zawsze „nad” pozostałymi 

Program domyślnie wskazuje informacje o danym klipie takie jak rozdzielczość czy użyte 

codecki w przypadku plików filmowych 

Po uzupełnieniu poszczególnych pól należy zatwierdzić zmiany przyciskiem „OK.” 
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Dodawanie stron WWW 
 

Aby dodać stronę WWW jako klip należy wybrać opcję dodania nowego klipu a następnie w ścieżce 
dostępu do pliku wpisać adres witryny poprzedzając go http:// . 

Przykład na rysunku. 

Rysunek 14 Klip WWW 

 

 

Specjalne właściwości klipów typu strona WWW 
 

Zoom Dostępne wartości: 0.1/0.2/0.3… gdzie 1 to 100%. Funkcja odpowiada za 
przybliżenie lub oddalenie 
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Show URL 
Addres 

Przyjmuje wartości o lub 1 gdzie 1 wyświetla adres otwieranej strony podobnie jak 
w przeglądarce WWW 

 

 

Show keyboard Dostępne wartości 0 lub 1, gdzie 1 wyświetla klawiaturę, którą można wprowadzić 
tekst. Funkcja pomocna przy tworzeniu interfaców dotykowych np. w infokioskach 
lub infomatach. 

 

 

Show without 
wait 

Dostępne wartości 0 lub 1, gdzie przy użyciu wartości 1 strona otwiera się 
bezpośrednio na ekranie, użycie wartości 0 powoduje oczekiwanie playera na 
załadowanie treści i wyświetlenie w pełni pobranej strony. 

URL with data Dostępne wartości 0 lub 1, gdzie użycie wartości 1 włącza pobieranie przez klipy 
zewnętrznej zawartości a następnie zapisanie jej w pliku stworzonym w katalogu 
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profilu, dzięki czemu można ograniczyć zapotrzebowanie na ciągłe 
synchronizowanie danych z zewnętrznym źródłem. Taki plik należy stworzyć w 
folderze z profilem. 

Local data 
Filename 

Funkcja bezpośrednio połączona z wyżej wymienioną właściwością. Należy podać 
nazwę pliku w jakim zostaną zapisane zewnętrzne dane. Np.: dane.txt 

Backup URL 
with data 

W przypadku wykorzystania systemów backupowych należy podać adres do źródła 
danych, które zostanie automatycznie użyte w przypadku braku połączenia z 
pierwszym. 

Data refresh 
interval 

Częstotliwość odświeżania danych zapisanych w lokalnym pliku (patrz funkcja 
„Local  data Filename” ) podane w milisekundach domyślnie (60000 ms) 

Run Hidden Dostępne wartości 0 lub 1, opcja jest powiązana bezpośrednio z funkcją Add 
Treigger. Wybranie wartości 1 ładuje stronę WWW ale jej nie wyświetla. 
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Dodawanie klipu Trigger 
 

Klip Trigger używany jest w przypadku klipów typu WWW i służy do wyświetlania ich po 
wcześniejszym zmagazynowaniu w pamięci komputera. 

Aby wykorzystać funkcje Trigger należy dodać klip typu strona WWW jako klip dynamiczny.  

 

Następnie we właściwościach danego 
klipu w linii „Show without wait” 
wpisujemy 1 (ta opcja wyświetli stronę 
bez oczekiwania na załadowanie) oraz 
w linii „Run Hidden” wpisujemy 1 (ta 
opcja domyślnie ukryje klip). 

 

Należy również nadać numer ID klipu 
ponieważ będzie on niezbędny przy 
późniejszej konfiguracji. 

 

 



 

25 
 

Aby użyć funkcjonalności Trigger należy dodać ją poprzez menu kontekstowe klikając prawym 
przyciskiem myszki na obszarze podstawowej play listy (lista klipów statycznych). 

 

Rysunek 15 Dodawanie klipu Trigger 

 

 

 

 

W celu zdefiniowania treści do wyświetlenia należy w Panelu Właściwości w części Zdarzenia (Events) 
użyć funkcji Show i Hide odpowiednio w momencie rozpoczęcia i zakończenia trwania Triggera. 

 Show ID; 
Hide ID;  
Gdzie w miejsce ID wpisujemy numer 
ID wcześniej dodanego klipu. 

 

UWAGA 

Trigger nie jest klipem zawierającym treść do wyświetlenia tylko „zdarzeniem” na playliście 
klipów, który określa czas trwania innego zdarzenia. Dodanie klipu typu Trigger spowoduje 
wyświetlenie treści zdefiniowanej przy pomocy URVE Script. 
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Dodawanie tickera tekstowego 
 

Ticker tekstowy to specjalny rodzaj klipu, który umożliwia odtwarzanie tekstu w formie przewijanego 
paska tekstowego. Ticker może być uruchamiany na żądanie wraz z innym plikiem multimedialnym lub 
jednorazowo, automatycznie aktualizując treści w trakcie trwania całego programu.   

  

Aby dodać ticker należy przełączyć widok obszaru roboczego na zakładkę „Dynamiczne” a następnie: 

1. Pasek narzędzi -> Dodaj tiker tekstowy (Toolbar ->Add advanced text ticker…) 
2. Menu Dodaj -> Dodaj tiker tekstowy (Menu Add ->Add advanced text ticker…) 
3. Menu kontekstowe na zakładce Dynamiczne -> Dodaj tiker tekstowy” („Add advanced text 

ticker…”) 
 

Każda z tych czynności spowoduje otwarcie nowego okna dialogowego „Ticker tekstowy” („Advanced 
text ticker”). 

 

Rysunek 16 Dodawanie tickera tekstowego 

 

 

Parametry odpowiedzialne za prędkość przesuwania się tekstu. Parametry te są istotne  
w przypadku odtwarzania na ekranach LCD.  

UWAGA 

Ze względu na specjalne możliwości tickera należy zawsze dodawać go w zakładce klipów 
dynamicznych.   
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 Współrzędne oraz wymiary tickera na ekranie 

Źródło wyświetlanych danych, w zależności od wymagań może to być kanał RSS lub tekst 
wpisany odręczenie 

 Parametry odpowiedzialne za opóźnienie w pojawianiu się tickera na ekranie.  

 Właściwości tickera związane z jego uruchomieniem się oraz sposobem pojawienia 

 Właściwości wyświetlanych czcionek 

 

Zmiany zatwierdzamy przyciskiem OK. Na ekranie pojawi się czarny obszar w którym możemy 
edytować graficznie ułożenie i wielkość tickera. Zmiana prezentacji graficznej automatycznie zmienia 
parametry wcześniej podane w oknie dodawania tickera. 

Zmiany ustawień graficznych zatwierdzamy poprzez klawisz Esc lub poprzez wywołanie menu 
kontekstowego i wybranie opcji Potwierdź (Done). 

 

Ustawianie źródła wyświetlanych danych 

Wyświetlanie danych wprowadzonych manualnie 

 

Po uruchomieniu ticker będzie 
wyświetlał dane wprowadzone  
w polu. 
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Wyświetlanie danych ze źródła RSS 

 

W polu należy wpisać adres kanału 
RSS z którego mają być pobierane 
dane. Po uruchomieniu ticker 
będzie wyświetlał wskazane źródło  
i automatycznie aktualizował treści. 
W przypadku braku połączenia  
z Internetem zostanie wyświetlony 
tekst wpisany manualnie. 

 

Wyświetlanie danych pobieranych z pliku txt 

 

W polu adresu kanału RSS należy 
podać ścieżkę do pliku na dysku 
oraz należy zaznaczyć opcję „URL 
jest lokalnym plikiem tekstowym”. 
Dane muszą zostać zapisane w 
pliku *.txt. Po uruchomieniu ticker 
będzie wyświetlał dane pobrane z 
pliku txt. W przypadku, gdy plik 
będzie pusty zostanie wyświetlony 
ticker bez tekstu. 

 

 

Domyślnie ticker dodany zostaje w funkcją automatycznego uruchomienia w momencie uruchomienia 
domyślnej playlisty. W celu zmiany tych ustawień należy sprawdzić numer ID tickera (panel 
Właściwości) a następnie w panelu Zarządzanie przejść do części „Wydarzenia”. W wierszu 
OnAfterPlay będzie znajdował się wpis w postaci „PlayOnce [ID]”. Po usunięciu wpisu ticker nie będzie 
odtwarzał się przy uruchomieniu domyślnej playlisty. 

Pozostałe właściwości tickera można zmieniać w panelu Właściwości. 
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Właściwości klipów 
 

Dodane klipy zawierają wiele wartości domyślnych. Aby dopasować profil do potrzeb Użytkownika 
mamy wiele możliwości manipulowania ich opcjami. W celu podglądu i modyfikacji właściwości danego 
klipu, należy wskazać i zaznaczyć odpowiedni plik z listy. Dostępne parametry modyfikacji widoczne są 
w Panelu Properties, którego poszczególne funkcje omówimy poniżej. 

File name Nazwa pliku, który jest źródłem klipu 

Active W przypadku tej zmiennej dostępna jest tylko wartość True lub False. W 
przypadku zaznaczenia wartości True klip zostanie odtworzony w profilu, zaś w 
przypadku False, klip będzie widoczny tylko w programie URVE Manager, zostanie 
wysłany na serwer jednak ostatecznie nie będzie odtwarzany na urządzeniu 
docelowym. Wartość tej zmiennej jesteśmy w stanie zmienić także na obszarze 
roboczym Playlisty programu odznaczając lub zaznaczając Checkbox przy klipie. 
Możliwości przedstawiają rysunki poniżej. 

 

 

ID Niezbędny przy tworzeniu zaawansowanych profili z klipami dynamicznymi. 
Powinna być to liczba naturalna np 1. O wykorzystaniu i odwoływaniu się do ID 
klipu w dalszej części instrukcji. 

Duration Czas wyświetlania klipu. Liczone od momentu wyświetlenia a nie załadowania 
klipu. Długość wyświetlanego klipu może być krótsza niż sam czas trwania 
materiału.  

Załóżmy, że dodany film trwa w rzeczywistości 30 sekund, jednak chcemy, aby 
została wyświetlona tylko połowa. Zatem czas trwania wynosi 30 000 milisekund - 
aby uzyskać zamierzony efekt – pokaz połowy klipu – wpisujemy wartość 15 000. 

Debug mode  

Use alpha  

Alpha Wait  

Max alpha  
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Border color Parametr służący do określania koloru ramki, (jeśli takowa ma być zaznaczona 
wokół wskazanego klipu) 

Border width Parametr służący do określania szerokości ramki wokół klipu. 

Screen Y Współrzędna Y na ekranie 

Screen X Współrzędna X na ekranie 

Width Szerokość klipu. 

Height Wysokość klipu. 

On top Dostępne wartości dla tej zmiennej to, 0 – gdy klip będzie wyświetlał się pod 
innymi klipami lub 1 – gdy chcemy, aby klip odtwarzał się ponad pozostałymi 
klipami. Funkcja wykorzystywana głównie przy klipach dynamicznych oraz podczas 
zarządzania kolekcjami. 

Repeat Funkcja wykorzystywana do klipów, które mają być wyświetlane w 
nieskończoność, głównie służąca do zarządzania tickerami tekstowymi. Parametr 
ten NIE MOŻE być używany do klipów znajdujących się w zakładce timeline, gdyż 
w efekcie klip będzie się „nawarstwiał” mogąc powodować nieprawidłowości w 
funkcjonowaniu urządzenia wyświetlającego. 

Transparent Parametr używany TYLKO do zarządzania tickerami tekstowymi, umożliwia 
wyświetlanie tekstu na przeźroczystym tle. 

Transition effect  

Effect number  

Effect step  

Flash Vars  

Zoom  

Group W tym parametrze należy określić grupę urządzeń, na których ma być wyświetlany 
klip. Brak wartości w polu (domyślne) powoduje wyświetlenie klipu na 
urządzeniach wszystkich grup. Nazwy grup należy podawać pooddzielane 
przecinkami (bez spacji). Na przykład grupa1,grupa2 



 

31 
 

Players W tym parametrze należy wpisać nazwy urządzeń, na których ma być wyświetlany 
klip. Brak wartości w polu (domyślne) powoduje wyświetlenie klipu na wszystkich 
urządzeniach. Nazwy urządzeń należy podawać pooddzielane przecinkami (bez 
spacji). Na przykład urządzenie1,urządzenie2. 

Simultanious 
play (Movie) 

 

Simultanious 
wait (Movie) 

 

Net synchro 
port 

 

Network latency  

Show URL 
adress 

 

Show keybord  

Flash Vars 
(SWF) 

 

Alphablend 
(SWF) 

 

Show without 
wait (WWW) 

 

Show touch 
(Picture) 

 

Remove aspect 
ratio (Movie) 

 

Render method 
(Movie) 

 

Cut margins 
(Left, Top, 
Right, Bottom) 
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Efekty przejść pomiędzy klipami 
 

System URVE umożliwia stworzenie przejść pomiędzy klipami, zarówno w formie „przenikania się” 
klipu poprzedniego z następującym, jak i efektów graficznych (typu Power Point). 

W systemie dostępne są 54 efekty przejść.  

 

Aby uruchomić tą funkcjonalność w 
panelu „Właściwości” w prawym 
górnym rogu należy w opcji 
Transition effects ustawić wartość 
‘1’.  

Effect number w zakresie od 0 do 
54  oraz Effect Step wartość od 0 
do 100 gdzie 0 oznacza najkrótsze 
trwanie efektu zaś 100 najdłuższe. 

W przypadku gdy opcja Effect 
number pozostanie pusta program 
zastosuje losowe efekty przejść. 

 

Istnieje możliwość ustawienia 
efektu przenikania klipów dla całej 
playlisty. Aby uzyskać taki efekt 
należy we właściwościach 
wybranego obszaru ustawić 
wartość opóźnienia (wartość 
podawana w milisekundach). 
Przenikanie klipów zostanie 
wówczas zastosowane dla 
wszystkich klipów pojawiających się 
w danym obszarze. 
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UWAGA 

W przypadku wykorzystania efektów przejść oraz przenikania się klipów należy upewnić się że 
parametry techniczne i wydajność playera odtwarzającego są wystarczające.  

Efekty przenikania się klipów dostępne są na systemie operacyjnym Microsoft Vista lub wyżej. 
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Zarządzanie obszarami 
 

Dzięki funkcjonalności URVE Manger możliwe jest niezależne zarządzanie fragmentami ekranu poprzez 
wewnętrzne kolekcje. Korzystając z tej opcji można podzielić ekran na praktycznie dowolną liczbę 
mniejszych obszarów, z których każdy będzie miał niezależnie odtwarzającą się listę klipów 
statycznych oraz dynamicznym. 

Zarządzanie obszarami odbywa się poprzez zakładkę „Zawartość ekranu” („Screen contents”) 
dostępną w Panelu Powitalnym (Wolcome Panel). Po przełączeniu widoku na tą zakładkę możemy 
zobaczyć przestrzeń podzieloną na dwie części. 

 

Rysunek 17 Panel Powitalny – Zawartość ekranu 

 

W górnej części  znajduje się lista dostępnych playlist. Klikając na wybraną możemy edytować jej 
zawartość, klipy statyczne oraz dynamiczne, ich właściwości oraz harmonogram. 

W dolnej części  znajduje się lista obszarów wraz z przypisanymi do nich playlistami.   

Aby dodać nową playlistę należy prawym przyciskiem myszki kliknąć na odpowiednim obszarze ( )  
i z menu kontekstowego wybrać funkcję „Nowy”. Już na tym etapie możemy nadać nazwę a następnie 
dodać play listę poprzez opcję „Dodaj playlistę”. 

Analogicznie dodajemy nowy obszar wywołując menu kontekstowe w części obszarów ( ) wybierając 
funkcję Nowy -> Dodaj obszar ekranu. 
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Program automatycznie przypisze pierwszą dostępną playlistę do utworzonego obszaru oraz uaktywni 

obszar. Aby zmienić przypisaną playlistę należy przeciągnąć nazwę wybranej playlisty z części na 
nazwę wybranego obszaru. 

Poprzez check box znajdujący się po lewej stronie obszaru możemy zmienić czy dany obszar jest 
aktywny czy nie. Nieaktywny obszar nie będzie wyświetlany na ekranie. 

Zarządzanie obszarami i przypisanymi play listami jest bardzo ważne w odniesieniu do harmonogramu. 
Przypisana playlista do danego obszaru oznacza iż będzie to domyślnie odtwarzana kolekcja, jednak  
w przypadku wykorzystania harmonogramu w danym obszarze mogą wyświetlać się różne playlisty.   

Obszary mogą mieć dowolną wielkość oraz położenie na ekranie. Zarządzanie położeniem  
i rozdzielczością może odbywać się poprzez okno właściwości obszaru lub scenę graficzną. 

Aby edytować właściwości obszaru należy wywołać menu kontekstowe poprzez kliknięcie prawym 
przyciskiem myszki na wybranym obszarze a następnie wybrać opcję „Właściwości”. Pojawi się okno 
dialogowe w następującej postaci. 

 

Rysunek 18 Okno właściwości obszaru 

 

 

 Pole playlista określa jaka playlista domyślnie będzie odtwarzana w danym obszarze 

 Ustawienia współrzędnych oraz rozdzielczości obszaru 

Pole „Clip overlaping” określa długość efektu przejścia pomiędzy klipami znajdującymi się w 
kolekcji (więcej informacji w rozdziale „Efekty przejść pomiędzy klipami). 

URVEScript umożliwia zaprogramowanie zdarzeń podczas rozpoczęcia i zakończenia 
odtwarzania obszaru. 

Zmiany zatwierdzamy przyciskiem OK. 
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W celu edycji obszaru możemy wywołać również funkcję 

1. Menu Edit → Edytuj scenę 
2. Menu kontekstowe → Edytuj scenę obszaru 

Wywołanie tej funkcji spowoduje przejście programu w tryb edycji ustawienia ekranu. Na czarnym tle 
pojawią się prostokąty, które można przesuwać oraz zmieniać ich obszar. Wprowadzone graficznie 
zmiany zatwierdzamy klawiszem „ESC” lub poprzez menu kontekstowe opcja „Done”. 

 

Nazwy poszczególnych kolekcji jak i obszarów można zmienić klikając na wybranej kolekcji (lub 
obszarze) prawym przyciskiem myszki po czym z wywołanego menu należy zaznaczyć opcję „Zezwól 
na zmianę nazwy”. Następnie poprzez naciśnięcie lewym przyciskiem myszki na wybranej play liście 
lub obszarze można dokonać zmiany nazwy. 

 

 

UWAGA 

W lewym górnym rogu każdego obszaru na scenie graficznej znajduje się informacja o nazwie 
obszaru, przypisanej playliście oraz współrzędnych. 
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Harmonogram 
 

Harmonogram zdarzeń umożliwia zarządzanie, która play lista (kolekcja) ma się wyświetlić w 
określonym czasie. Głównym założeniem systemu URVE jest, iż przez cały czas odtwarzana jest 
przynajmniej jedna kolekcja – jeżeli użytkownik nie ustawi inaczej będzie to kolekcja domyślna. Zatem 
aby zmienić wyświetlane treści należy zaznaczyć w zakładce „Harmonogram zdarzeń” o jakiej porze 
ma zostać zmieniona playlista w jakim obszarze. 

Aby zobrazować sposób wykorzystania harmonogramu poniżej przedstawiona zostanie krok po kroku 
procedura ustalania harmonogramu dla ekranu LED, gdzie w dzień wyświetlana jest jedna playlista a 
w nocy druga. 

Rozpoczynamy od stworzenia dwóch playlist (Panel Powitalny -> Zakładka Zawartość Ekranu). Ich 
nazwy ustawiamy zgodnie z własnymi preferencjami. 

Następnie tworzymy obszar, który będzie odpowiadał części ekranu, na której chcemy aby wyświetlały 
się playlisty. W naszym przykładzie obszar ten będzie obejmował cały ekran. 

Kolejnym etapem jest przypisanie odpowiedniej kolekcji do obszaru.  

Załóżmy, że najważniejsze jest aby ekran wyświetlał o określonej godzinie konkretną play listę a przez 
pozostały czas prezentował czarny obszar. 

Aby uzyskać taki efekt do kolekcji „Nocna” dodajemy jeden klip – czarne, jednolite tło. Po czym 
kolekcję „Nocna” przypisujemy do obszaru „Pelen_ekran” (np. poprzez przeciągniecie przy pomocy 
myszki playlisty „Nocna” na obszar „Pelen_ekran). Oznacza to, że w obszarze „Pelen_ekran” będzie 
widoczne tylko czarne tło, które będzie odtwarzane domyślnie w trakcie pracy playera. 

Do playlisty „Dzienna” dodajemy dowolne treści które chcielibyśmy wyświetlić. 

Następnie przełączamy widok obszaru roboczego na zakładkę „Harmonogram”. We wskazany dzień 
oraz o wybranej godzinie należy prawym przyciskiem myszki wywołać menu kontekstowe a następnie 
wybrać opcję „Wstaw” i wybrać playlistę, którą chcemy  danym momencie wyświetlić – w naszym 
przypadku „Dzienna”. Przy pomocy myszki możemy „złapać” krawędź dodanej playlisty i zwiększyć jej 
obsza na przedział czasowy, który nas interesuje.  

Ostatnim etapem jest przypisanie play listy na harmonogramie do odpowiedniego obszaru. W tym celu 
należy prawym przyciskiem myszki nacisnąć na polu dodanej play listy i z menu kontektowego wybrać 
„Właściwości”. Na ekranie pojawi się okno dialogowe w następującej postaci. 

1. Możemy wpisać czas aktywności playlisty manualnie 

2. Należy wybrać w jakim obszarze dana playlista powinna się wyświetlić. W omawianym 
przypadku playlista „Dzienna” ma się wyświetlić w obszarze „Pelen_ekran” 

3. Rozpoczęcie lub zakończenie odtwarzania danej playlist może wywoływać dowolne zdarzenie 
oprogramowane przy pomocy URVEScript 

Zmiany zatwierdzamy przyciskiem OK 

Tak przygotowany harmonogram oznacza, że w trakcie pracy playera odtwarzana będzie playlista 
„Nocna” zaś o wskazanej godzinie (w naszym przypadku od 8:00 do 9:00) odtwarzana będzie playlisa 
„Dzienna”. 
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Podgląd klipu oraz kanału (profilu) 
 

Jedną z możliwości URVE Manager jest podgląd pojedynczego klipu jak i całego profilu. Dzięki temu 
Użytkownik może zobaczyć na urządzeniu lokalnym, w jaki sposób będzie odtwarzany film lub profil, 
na urządzeniu docelowym. 

Podgląd klipu jest widoczny w oknie dodawania nowego klipu (New clip), ale także poprzez:  

1. Pasek Główny → “Preview” 
2. Menu Edit → “Preview” 
3. Menu Podręczne → “Preview” 

Podgląd pełnego profilu dostępny jest poprzez: 

1. Menu Commands → “Local profile preview” 

Podgląd pojedynczego klipu (z pominięciem podglądu w oknie „New clip”) może być anulowany 
przyciskiem „ESC” lub poprzez kliknięcie prawym przyciskiem myszy na ekranie i z wywołanego menu i 
późniejsze wybranie opcji „Close URVE Player” 
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Aktualizacja urządzeń 
 

Po zakończeniu tworzenia kanału (profilu), należy wysłać ustawienia na urządzenie odtwarzające, 
wyposażone w URVE Player. W zależności od rodzaju połączenia urządzeń (lub ich braku) należy 
wybrać jedną z wymienionych opcji. 

Urządzenia typu „Stand alone” 
W przypadku, gdy urządzenie odtwarzające nie jest dostępne w sieci, w której znajduje się URVE 
Manager należy wykorzystać możliwość eksportu profilu na przenośny nośnik danych typu PEN Drive. 

Menu Plik → „Eksportuj kanał” (Menu File -> „Export profile…”) 

Urządzenia połączone w sieci LAN 
W przypadku, gdy urządzenia odtwarzające znajdują się w obrębie tej samej sieci LAN, co komputer z 
zainstalowanym URVE Manager, możemy wykorzystać następujące opcje w celu aktualizacji. 

1. Panel Powitalny → “Synchronize all LAN players” 
2. Panel Powitalny → Zakładka Players → kliknięcie prawym przyciskiem myszki na wybranym 

playerze umożliwia opcję „Synchronize selected” lub „Synchronize all LAN players” 
3. Panel Zarządzania → Zakładka Players → „Synchronize all LAN players” 

Urządzenia w sieci rozproszonej – aktualizacja poprzez serwer 

 
 

Jeśli urządzenia znajdują się w rozproszonych lokalizacjach i aktualizacja odbywa się zdalnie przy 
pomocy serwera, możemy wywołać opcję w następujące sposoby: 

1. Menu File → „Upload profile…” 
2. Panel Powitalny → „Upload profile to URVE server” 
3. Panel Zarządzania → „Upload profile to URVE server”  

UWAGA 

Przed przystąpieniem do aktualizacji należy się upewnić czy ustawienia konta na serwerze są 
poprawne. 



 

40 
 

Słownik pojęć 

 
Drag&Drop – w dosłownym tłumaczeniu „przeciągnij i upuść” udogodnienie umożliwiające 
dodawanie nowych klipów poprzez przeciągnięcie ich z wybranego katalog na obszar roboczy aplikacji 
URVE Manager 

Kanał (Profil) - Zbiór Playlist w obrębie jednej sieci Digital Signage. Kanał (profil) umożliwia 
zarządzanie poszczególnymi Playlistami na przestrzeni czasu niezależnie od głównej Playlisty Profilu. 

Klip – pojedynczy plik, który ma zostać wyświetlony - podstawowy obiekt w programie URVE 
Manager. Wyróżniamy klipy dynamiczne i statyczne. Wszelkie parametry i możliwości manipulacji 
klipami opisane są w dalszej części instrukcji. 

Player – urządzenie podłączone do monitora odpowiedzialne za emisje treści 

Playlist(a) - zbiór klipów oraz przypisanych do nich reguł 

Profil – patrz „Kanał” 

Ticker tekstowy – klip wyświetlający przesuwający się tekst 

Trigger  – klip specjalny określający długość wykonania innych zdarzeń w obrębie danego kanału 
(profilu). Trigger nie posiada treści do wyświetlenia 

URVE Manager – aplikacja służąca do zarządzania wyświetlanymi treściami oraz ustalania 
harmonogramu ich prezentacji na zdalnych nośnikach 

URVE Player – aplikacja instalowana na Playerze w celu ułatwienia zarządzania kontenetem i 
parametrami wyświetlania 

URVE Server – aplikacja odpowiedzialna za dystrybucją treści na player oraz gromadzenie statystyk. 
Wykorzystywana głównie w przypadku instalacji o charakterze komercyjnym lub w rozproszonych 
sieciach 

URVE Script – język programowania platformy URVE umożliwiający zadawanie komand i poleceń do 
zdalnie odtwarzanych klipów 

Urządzenie docelowe - urządzenie służące do odtwarzania przy pomocy URVE Player zapisanego  
i wysłanego na serwer (lub urządzenie) Profilu lub Playlisty 
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